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Training Participants 

 District Test Coordinators (DTCs) 
 School Test Coordinators (STCs) 
 District and School Technology Coordinators 
 Test Examiners 

 Classroom teachers 
 Special education teachers 
 Translators 
 Proctors 
 Other district personnel who help with test administration 

 



Additional EOC Trainings 

 EOC Trainings are also 
available for: 
 After Testing 
 Alternative Testing Formats 
 Blueprints and Timing 

Guidelines 
 EOC Process 
 Important Dates to Remember 
 Practice Tutorials & Pre-Tests 

 

 
 

 Test Tickets 
 Testing Day 
 Testing Issues 
 Universal Tools and 

Accommodations 
 Using iTester Admin 
 Who Is Tested 



Accessing the Trainings 

 DESE Assessment webpage under EOC training 
 http://dese.mo.gov/college-career-readiness/assessment/end-course 

 iTester Admin page under the Help tab 
 http://moeoc.questarai.com/Admin 

http://dese.mo.gov/college-career-readiness/assessment/end-course
http://moeoc.questarai.com/Admin


Subjects Tested 

 Required 
 Algebra I 
 English II 
 Government 
 Biology 

 
 
 

 
 
 

 Optional (For Local Use) 
 *Algebra II  
 Geometry 
 English I 
 American History 
 Physical Science 

 
 
 
 



Testing Timelines 

Administration Pre-Code Due By Students In 
iTester By 

Students Can 
Test By 

Fall 2016 
10/3/16 – 
1/20/17 

9/16/16 9/26/16 10/3/16 
11/4/16 11/15/16 11/21/16 

Spring 2015 
2/20/17 – 
5/26/17 

1/27/17 2/13/17 2/20/17 
3/3/17 3/17/17 3/20/17 

3/31/17 4/14/17 4/17/17 

DTCs must specify the district assessment windows for each content area. 
Districts have 7 business days per content area to administer the 
assessments. Once the district testing window has ended, iTester will 
close and no further tests will be accessible without contacting Questar. 



Costs for EOC Assessments 

 Required: 
 Algebra I - $1.80 
 English II - $1.80 
 Biology - $1.80 
 Government – Free 

 
 
 

 
 
 



Reminders 

 Resources to consult: 
 The Test Administration Manual (TAM) 
 2016-2017 LEA Guide to the Missouri Assessment Program 
 DESE EOC Website 

 http://dese.mo.gov/college-career-readiness/assessment/end-course 

 Your District Testing Coordinator (DTC) 

http://dese.mo.gov/college-career-readiness/assessment/end-course
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Universal Tools & Accommodations 

 Two categories: 
 Universal Tools 
 Accommodations 

 There are no accommodations for use on EOCs that cause an 
invalidation 
 
 

 



Universal Tools 

 Universal Tools 
 Available to all students taking EOC assessments, unless otherwise 

noted 
 Some tools are only for use by English Language Learner (ELL) students 

(ELL students are those marked LEP-RCV or LEP-NRC in Core Data) 
 Some tools need to be marked in iTester prior to the assessment. 

Please read the description to determine if the tool must be marked in 
iTester. 
 
 

 
 



Universal Tools 

Tool Description Code 
Bilingual 
Dictionary 

ELL students may have access to a physical Bilingual Dictionary for use ONLY on the Writing Prompt 
for the English I and English II assessments. If the Bilingual Dictionary is electronic, it may not 
connect to the internet. 
  
This tool must be chosen in the iTester system under student accommodations prior to testing. 

S431 

Break 
(Pause) 

All students may take breaks of up to 20 minutes as needed. There is no limit to how many times a 
student may use this during an assessment. 
  
If a student hits the pause button, they will be logged out. They can log back in anytime that same 
day. If the assessment needs to be reopened on a subsequent day, the district will need to call help 
desk. 
  
If the need arises to move a student from one computer to another, pause the test to exit. The test 
will remain incomplete until the student logs back in and completes the test. 

N/A 

Color 
Contrast – 
Paper 
 

All students taking the paper/pencil assessment may have the test printed in different colors based 
on student needs or preferences. 
  
This tool must be chosen in the iTester system under student accommodations prior to testing. 

S102 
 



Accommodations 

 Accommodations 
 Must appear in an IEP or 504 plan 
 Some accommodations are only for use by English Language Learner 

(ELL) students (ELL students are those marked LEP-RCV or LEP-NRC in 
Core Data) with an IEP/504 

 All accommodations need to be marked in iTester prior to the 
assessment 



Accommodations 

 Accommodations for Missouri EOCs aligned to new 
accommodations being used for the MAP Grade-Level 
assessments 

 Greater flexibility in providing accessibility for all students 
 

 



EOC Read Aloud 

 All directions and items in any subject, except ELA reading 
passages, may be read by a trained reader 

 Read aloud of an ELA reading passage requires an IEP or 504 plan 
 Decision to read aloud should be made by educators who work 

with the student on a regular basis 
 DESE does not recommend the use of Read Aloud for students 

who do not use it as part of their everyday learning in the 
classroom. The use of Read Aloud for some students can prove 
distracting and become a hindrance to student performance 

 Completed in a small group or individual setting 



Text-To-Speech (TTS) 

 As a new feature this year, the iTester platform allows 
students to have the test directions and items read aloud 
via embedded text-to-speech technology 

 The student can control the speed and volume of the voice 
 Students should have multiple exposures or pratice using 

the synthetic voice in TTS.  If districts or students are not 
comfortable with TTS, they can still use a Human Reader. 

 The TTS tool must be turned on in the system prior to 
testing 
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Blueprints – Algebra I 

 
 



Blueprints – Algebra II 

 
 



Blueprints – Geometry 

 
 



Blueprints – English I 

 
 



Blueprints – English II 

 
 



Blueprints – Biology 

 
 



Blueprints – Physical Science 

 
 



Blueprints – Government 

 
 



Blueprints – American History 

 
 



 
 
 
 
 

Content Time Suggestions 
English II Session I: 90 – 110 min / Session II: 90 – 110 min 
Algebra I Session I: 90 – 110 min / Session II: 60 - 70 min 
Biology Session I: 55 – 60 min / Session II: 65 - 70 min 
English I Session I: 90 – 110 min / Session II: 90 – 110 min 
Algebra II 90 – 110 min 
Geometry 90 – 110 min 
American History 60 – 80 min 
Government 60 – 80 min 
Physical Science 60 – 80 min 
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Important Dates 

 Please check the DESE website often for updates 
 dese.mo.gov → MAP → EOC → Important Dates 

 

 



Important Dates 
Administration Dates Event 

Fall 2016 

DUE September 16, 2016 Fall 2016 First Precode (students available in iTester 
9/26/16 - students may begin testing 10/3/15) 

October 3, 2016 to January 20, 2017 Fall 2016 Window 

DUE November 4, 2016 
Fall 2016 Second Precode (students available in 
iTester 11/15/16 - students may begin testing 
11/21/16) 

Spring 2017 

DUE January 27, 2017 
Spring 2017 First Precode (students available in 
iTester 2/13/17 - students may begin testing 
2/20/17) 

February 20, 2017 to May 26, 2017 Spring 2017 Window 

DUE March 3, 2017 
Spring 2017 Second Precode (students available in 
iTester 3/17/17 - students may begin testing 
3/20/17) 

DUE March 31, 2017 
Spring 2017 Third Precode (students available in 
iTester 4/14/17 - students may begin testing 
4/17/17) 



Important Dates 

 Inform parents/ guardians of upcoming testing dates 
 Minimize schedule conflicts 
 Students participate when they complete associated course 

content 

 



Important Dates 

 7 business days for each content area 
 Identify a window for each content area 
 Tests with more than one session are not required to be 

completed in the same day 



  
 
 
 
 

Content Time Suggestions 
English II Session I: 90 – 110 min / Session II: 90 – 110 min 

Algebra I Session I: 90 – 110 min / Session II: 60 - 70 min 
Biology Session I: 55 – 60 min / Session II: 65 - 70 min 
English I Session I: 90 – 110 min / Session II: 90 – 110 min 

Algebra II 90 – 110 min 
Geometry 90 – 110 min 
American History 60 – 80 min 
Government 60 – 80 min 
Physical Science 60 – 80 min 
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Who is Tested? 

 Students participate when they complete associated course 
content 
 
 

 

Required Optional (For Local Use) 
Algebra I *Algebra II  

Biology American History 

English II English I 

Government Geometry 

Physical Science 



Who is Tested? 

 Missouri Option students 
 Homebound students 
 MoVIP students 



Who is Exempt from Testing? 

 Students eligible for MAP-A 
 ELL students who have been in the United States for less than 

12 cumulative months may be exempt from ELA assessments 

 



Questions about Exemptions? 

 Contact DESE’s Accountability Data office at (573) 526-4886  
 Keep track of each student’s EOC completions 
 See the EOC History Report on MCDS Portal 

 



Optional Populations 

 Foreign Exchange Students 
 Homeschooled Students 

 Make sure to check the Homeschool Box 
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A 13-Step Process 

 1.  Training Participants 
 2.  Setting Up iTester 
 3.  Site Setup 
 4.  Selecting Students 
 5.  Determining Content 

Windows 
 6.  Pre-Coding 
 7.  Final Preparations 

 8.  Special Considerations 
 9.  Accessing the Practice 

Tutorials 
 10.  Printing Test Tickets 
 11.  Testing 
 12.  Closing a Window Early 
 13.  Individual Student 

Reports 



Step 1: Training Participants 

 District Test Coordinator (DTC) 
 School Test Coordinator (STC) 
 Test Examiner (TE) 
 Other district personnel involved in testing 

 View appropriate recorded trainings 
 Review the Test Administration Manual (TAM) 

 



Step 2: Setting up iTester 

 iTester Administration site opens on: 
 9/26/16 (Fall) 
 2/15/17 (Spring) 
 After these dates, DTCs & STCs can create testing sessions 

 District IT staff should log in and download the latest version 
of the iTester student client and run workstation readiness 
tests 



Step 3: Site Setup 

 IT staff confirms that the building is ready for testing 
 STC or DTC confirms that within iTester Admin  

 



Step 4: Selecting Students 

 Who will test during the window? 
 Students who have completed the Missouri Learning Standards for 

the appropriate course and content 

 



Step 5: Determining Content Windows 

 7 business days for each content 
 Content windows can be separate or overlap 
 Must fall within the state testing window 

 



Step 6: Pre-coding 

 Populates students into iTester 
 Determine which pre-code window works best for your 

district 
 Pre-code during the window that accommodates your first 

anticipated content window 

 



Step 7: Final Preparations  

 Students are enrolled in the correct content area 
 Students are enrolled with correct test examiner 
 Changes can be made to student information and groups 
 Students can be manually added 



Step 8: Special Considerations 

 Paper/Pencil, Braille or Large Print assessments must be 
marked prior to testing 
 Braille and Large Print tests need to be ordered at least one week prior 

to testing 
 Paper/Pencil tests must be downloaded by the DTC and printed prior 

to testing 

 Other accommodations should be entered prior to testing 



Step 9: Accessing the Practice Tutorials 

 Students should be given ample time to access the tutorials 
 Students who are testing in an assessment that has a 

performance event or writing task, should review and 
practice the tools multiple times 

 Become familiar with the way the system works 
 Become familiar with the tools 
 Can be accessed at any time 

 



Step 10: Printing Test Tickets 

 iTester allows for batch printing of tickets 
 Distribute prior to testing 
 Will need session code if more than one session 
 Collect and securely destroy tickets after testing 

 



Step 11: Testing 

 Once all preparations are made it’s time to assess 
 Refer to the timing guidelines for each content 

 These are general timing estimates 
 For example, 60-80 minutes 

 Please plan accordingly 

 Answers from Paper/Pencil, Large Print and Braille tests must 
be entered into the system prior to the close of the 7 day 
window 



Step 12: Closing a Window Early 

 7 day window, if a district finishes early they may close the 
window 

 5 day turn around on results begins the business day after the 
window closes 

 To close a window early contact Questar at: 
 (800) 571-2545 

 



Step 13: Individual Student Reports 

 Five business days after the close of the district content 
window 

 DTCs can download student scores from the Reports tab 
 Individual Student Reports (ISRs) are available to download 

and print at the district level. 
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iTester Administration vs. Questar Secure 
Browser 

 iTester is the system used to manage and deliver the EOC 
Online Assessments. iTester consists of two main 
applications: 
 iTester Admin—An administrative web site used by test coordinators 

and Examiners to manage users and test sessions, student testing 
records, marking accommodations and other tasks before, during, and 
after testing 

 Questar Secure Browser—(formerly known as iTester Student) A test-
delivery application used by students to take their tests. It is a Java-
based application that must be installed on each student  workstation 
before testing begins 



iTester Administration Login 

 iTester Admin can be accessed at: 
http://moeoc.questarai.com/Admin/ 

 If you cannot remember your username/password, use the 
“Can’t Login” button found at the bottom of the Sign In box 

 If you do not have a login, please 
contact the EOC Help Desk at 
800-571-2545 
 

http://moeoc.questarai.com/Admin/


iTester Admin – Materials Ordering 

 Click on the Materials Ordering tab to order 
 Large print test 
 Braille test 

58 



iTester Admin - Examiners 

 Under the Examiners tab you can add examiners 
 Examiners are divided by subject 
 Examiners may be listed in more than one area 
 Edit examiners name, email and content areas 

59 



iTester Admin – Student Groups 

 In the Student Groups tab you can view groups scheduled to 
test in a subject 

 Create a new student group 
 Move a student to a new group 
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iTester Admin - Students 

 In the Students tab you can view students across all subjects 
and students not assigned to a student group 

 View students who are assigned to test in a subject 
 Add/Edit students 

 Any changes made to student demographics must also be made in 
DESE’s MOSIS system. 

 Change or add content area to be tested 

61 



iTester Admin – Test Sessions 

 Test Sessions 
 Filter By Testing Status:  

 All 

 In Progress 

 Finished 

 Not Started 
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iTester Admin – Test Sessions Cont.  

 Marking Tools/Accommodations/Status Codes 
 Click on Test Sessions tab 
 Click on the View Details/Student Logins 
 Click the Set link under the Student Accommodations and Status Codes 

in the appropriate row 
 In the pop-up window, choose the box next to the 

supports/accommodations and/or status codes 
 Click Submit button to save information 

63 



iTester Admin – Test Sessions Cont. 

 Printing Student Logins 
 Click on View Details/Student Logins link 
 Information sorts by last name 
 Click the Print Student test logins link above the table to view and/or 

print the student test logins. 
 Choose Print from the File menu to display the options dialog box for 

the printer. 
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iTester Admin - Reports 

 Reports 
 View Individual Student Reports  
 Print individual Student Reports 
 Download list (Excel CSV) 
 Order printed reports 
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iTester Admin - Accounts 

 Accounts tab 
 Create new accounts for test administrators 
 User Types 

 DTC- District Test Coordinator 
 DITC- District Information Technology Coordinator 
 STC- School Test Coordinator 
 SITC- School Information Technology Coordinator 
 Examiner- Examiner or Test Administrator 
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iTester Admin – Help Tab 

 Under the Help tab you can find manuals, trainings and other 
resources for EOC Assessments 
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Large Print or Braille 

 To order Large Print or Braille editions please contact Questar 
at: 
 (800) 571-2545 
 MOCustomerSupport@questarai.com 

 Order at least one week prior to testing 
 Accommodations codes 

 A012 for Braille 
 A021 for Large Print 

 

mailto:MOCustomerSupport@questarai.com


Paper/Pencil Editions 

 Paper/Pencil edition of the test is available for: 
 Students with an IEP that says the student should take the Paper Based 

Assessment 
 Students who are out-of-district 
 Homebound students who cannot come to school to test 
 For ELL Translation when the translator needs to do translation prior to 

assessing the student due to technical language 

 Use Accommodation code A102 for all scenarios 



Downloading Paper/Pencil Editions 

 DTC downloads and prints Paper/Pencil Editions 
 Individual test for each student 
 Cannot be saved to a computer or downloaded multiple 

times and must not be copied for any reason 

 



After Testing 

 Must immediately be transcribed into iTester 
 Paper/Pencil assessments must be returned no later than 24 

hours after the testing window closes 
 Use shipping materials from Questar 

 



Returning Hard Copy Tests 

 DTC is accountable for 100% of the returned shipment of 
each Paper/Pencil, Braille and Large Print test. 

 Report all Paper/Pencil, Braille, and Large Print assessments 
on the Test Book Accountability form  
 Instructions in the back of the TAM and in the Help tab in iTester 

Admin 
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Practice Tutorials 

 Tutorials are available in 
Questar Secure Browser for 
students to practice using the 
tools within the system 

 Open year round 
 Login information in the TAM 

and on DESE EOC Page 
 http://dese.mo.gov/college-

career-
readiness/assessment/end-
course 

 

CONTENT USERNAME PASSWORD 

Algebra I MOALG1 practice 

Algebra II MOALG2 practice 

Geometry MOGEO practice 

Biology MOBIO practice 

Physical Science MOPHYSC practice 

English I MOENG1 practice 

English II MOENG2 practice 

American History MOAMHIST practice 

Government MOGOV practice 

http://dese.mo.gov/college-career-readiness/assessment/end-course
http://dese.mo.gov/college-career-readiness/assessment/end-course
http://dese.mo.gov/college-career-readiness/assessment/end-course
http://dese.mo.gov/college-career-readiness/assessment/end-course


Pre-Tests - Online 

 Online Pre-Tests 
 Released EOC Forms 
 No specific testing window 
 Districts enroll students directly through iTester 
 If a student is precoded, a Pre-Test is available for them 
 Automatically scores selected response 
 Scores returned to districts within 24 hours of test submission 

 Pretests are available at no charge 
 



Pre-Tests - PDF 

 PDF form 
 Located in iTester under the Help tab or on DESE EOC Page 
 Last page includes the answer key and alignment of each item 
 Allows students to be familiar with the types of questions they can 

expect to encounter 



Pre-Tests Enrollment 

 Two ways that students are enrolled for the Pre-Tests: 
 For students included in the operational precode 

The operational enrollment file is also loaded into the pre-test 
administration. This means there will be a pre-test scheduled for each 
student included in the operational enrollment file, and nothing 
further needs to be done. 

 For students NOT included in the operational precode 
In order to enroll additional students in the pre-tests, meaning those 
excluded from the operational precode file, districts either must enter 
the student manually in iTester admin or create a pre-test enrollment 
file which must contain unique students who have yet to be created 
either in a previous precode file or manually. 



Accessing Pre-Tests 

 Each student will be given a unique username and password 
 Login information is generated and printed on test tickets 
 Pre-Tests can be reset by the DTC 



Pre-Test Results 

 CSV file with raw scores available 24 hours after student 
submission 

 Data for pre-tests available for 20 business days 
 Pre-Test ISRs (for multiple choice) also available 
 Pretests with a writing prompt or performance event 

 Locally scored using provided rubrics and scoring materials 
 Supplement to the TAM and brief training webinar are posted to 

iTester under the Help tab 
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Test Tickets 

 In order to test in iTester each student needs a test ticket with 
the following login credentials: 
 Username (MOSIS ID) 
 Password 
 Session access code 

 



Test Tickets 

 May be printed on: 
 Plain paper 
 Avery labels (5160) 

 In iTester, click on Test Sessions tab 
 View a list of registered students 
 Print tickets by student group 

 
 



Test Tickets 

 If a student is not listed: 
 STC or DTC creates a profile 
 Register student in a student group 
 Login information will be generated 

 



Test Tickets 

 When students log in have them check the ticket to verify 
their MOSIS ID 

 Have them verify the on-screen information: 
 Name 
 MOSIS ID 
 Date of Birth 
 Grade 
 Teacher Name 
 School Name 
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Test Day Materials 

 Required materials 
 Permitted but not provided materials 
 Prohibited materials while testing 
 Calculator Policy 
 



Test Day: Required Materials 

 Workstation with internet access 
 Student login information 
 Scratch paper for all assessments 
 Unlabeled grid or graph paper for Math and Biology 

assessments 
 Writing utensil 

 



Test Day: Permitted Materials 

 Hard copy of Mathematics Reference sheet 
 Hard copy of the Periodic Table of Elements 
 Calculators that meet TAM guidelines (Math only) 
 ELA writing task only 

 Dictionary 
 Thesaurus 
 Grammar handbook 
 Bilingual dictionary for ELL students 



Test Day: Prohibited Materials 

 Electronic devices that can connect to the internet or to 
anyone inside or outside the classroom 
 Cell Phones 
 Electronic Music Players 
 Digital Cameras 
 Handheld Scanners 
 Portable Gaming Devices 

 Cell Phones 
 Collect and return 

 



Test Day: Prohibited Materials 

 Students who have devices for health monitoring may have 
those devices in the room but they should not be accessed by 
the student unless it is necessary to monitor their ongoing 
health 
 



Test Day: Calculator Policy 

 DESE does not provide, endorse, or recommend a list of 
calculator brands or types 

 Calculators cannot contain stored equations or functions at 
the time of the End-of-Course Mathematics Assessments. 

 Test Examiners are responsible to ensure and verify that 
calculators that have the ability to store functions and 
equations, e.g., a graphing or a scientific calculator, have the 
memory cleared before and after each Mathematics 
Assessment.  

 Calculators cannot have Internet connectivity 
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Moving Students: In, Out or Within the District 

 If A Student Moves: 
 Into the district 

 Add them manually 
 If you can’t add them, contact Questar Customer Service 

 Out of the district prior to testing 
 Remove student from student group 
 Do not log into test 
 Do not mark any status codes 

 From building to building 
 Keep documentation 
 See page 15 of the TAM 

 



Student Drops 

 If a student was enrolled in an EOC, but later drops the 
course: 
 Remove from the student group in iTester 
 Do not: 
 Log into the test 
 Mark any status codes 

 



Absent Student or Incomplete Test 

 All students should take the entire EOC assessment 
 However, is a student is: 
 absent 
 not ready to test 
 has an incomplete EOC 

 Follow the procedures on page 16 of the TAM 

 



Moving Students: Disruption or Illness 

 Student may need to move during testing because of 
disruption or illness 
 Procedures are in the TAM 
 Pause the test 
 Escort the student to a new location  
 Login the student to a new workstation with the same operating 

system 



Loss of Internet Connection 

 Students test in iTester Student 
 Tests download to a student’s workstation 
 In the event of a lost connection: 

 Do NOT turn off the student’s device 
 Contact Questar at (800) 571-2545 
 Track student’s status in iTester Admin and ensure they submit their 

tests for scoring following each test session 

 



Loss of Internet Connection-continued 

 As a new feature this year, if 
Internet connection is lost, a 
small green dot on the corner 
of the screen will turn red 

 If this happens, contact 
Questar’s customer service 

 If you are using a portable 
device, do not close out, leave 
the testing platform open until 
connectivity is restored and 
then continue testing 



Invalidation 

 Tests are not invalidated because of: 
 Students behavior 
 Judgment of student effort 

 Only Invalidated because of cheating 
 Only the DTC can invalidate a test 
 Has to be done before the 7 day window closes 
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After Testing 

 DTC responsibilities: 
 100% return of all Paper/Pencil, Braille and Large Print 
 Questar will audit the returned shipments 
 Use the Test Book Accountability Form 

 
 Securely Destroy Immediately 

 Test Tickets 
 Scratch paper 
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After Testing 

 Downloading results 
 Located in iTester Admin 
 Download, save, and print the Individual Student Reports (ISRs) 

 Questar will send student score labels after the statewide 
window has closed 

 Districts have 15 days to notify parents or guardians that  ISRs 
are available 
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After Testing 

 Guide to Interpreting Results is available on DESE’s website 
 The Guide to Interpreting Results contains information 

regarding: 
 Scale scores 
 Achievement level descriptors 
 Standard error of measurement 
 Sample reports 
 Examples of student labels 
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dese.mo.gov 
(573) 751-3545 
assessment@dese.mo.gov 

Contact Us 

The Department of Elementary and Secondary Education does not discriminate on the basis of race, color, religion, gender, national origin, age, or disability in its programs and activities.  Inquiries related to 
Department programs and to the location of services, activities, and facilities that are accessible by persons with disabilities may be directed to the Jefferson State Office Building, Office of the General Counsel, 
Coordinator – Civil Rights Compliance (Title VI/Title IX/504/ADA/Age Act), 6th Floor, 205 Jefferson Street, P.O. Box 480, Jefferson City, MO 65102-0480; telephone number 573-526-4757 or TTY 800-735-
2966; email civilrights@dese.mo.gov. 
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